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Introduction 
 
Power*Log / Core & CurveÊ (Petrographical Office and Wellsite Evaluation and Reporting) is a chip sample and 
core logging program that utilizes single-entry data capturing to produce geological striplogs and corelogs. The 
geological data is entered into the system through the use of intuitive data entry forms to ensure standardization of 
data. This data is stored in an RDBMS (Relational Database Management System) to allow data manipulation using 
SQL (Structured Query Language) access tools. 
 

Power*Log / Core & CurveÊ Software consists of Four (4) Main Sections: 
 

1. A log editor module that allows you to change the striplogs to suit your needs and preferences. 
2. A data transfer module. 
3. Report printing modules. 
4. An on-line help system that is designed to familiarize you with the commands and functions available in 
Power*Log / Core & CurveÊ and lead you through many of the processes involved in creating logs. 

 

Starting Power*Log / Core & CurveÊé 

1. Double click on the Power*Log / Core & CurveÊ  icon. This brings you into the Power*Log / Core 
& CurveÊ program. The first window to appear will be the Security window with the registration and 

copyright information. Click on the  button to acknowledge the window. A Connect Database 
window will immediately appear. See the ñConnectò section, later in this User Manual to learn more about 
how to connect to a database. 

1. Highlight the Pgeology V9.0 Metric (Microsoft Access Driver [*.mdb]) database by clicking on it once, if 
it is not already highlighted.  

2. Move your mouse pointer to the User ID data field and click once to activate a flashing cursor in the User 
ID field. Then, type pgeology in the User ID field. Press the Tab key on the keyboard. 

3. Type pgeology in the Password field and then click on the  button. The program will now 
load various dictionaries and will activate an Open Log window. 

4. Double click on a log to open an existing log or click on the New Log  button to start a new log/well. 
You are now in the Power*Log / Core & CurveÊ environment. 

 

Navigating through Power*Log / Core & CurveÊ: 
 

When you are entering information into data forms, you may move between boxes/fields by pressing the Tab key to 
go forward and Shift +Tab to move backwards. To exit forms that do not have an Exit, OK, or Cancel button, press 
the Esc key on the keyboard. 
The various fields located in the Power*Log / Core & CurveÊ dialog boxes have character restrictions. ñField 
Restriction Tablesò are provided in this manual that provide a useful reference to help you enter the appropriate 
amount of characters or numbers in each field. 

Reading the Field Restriction Tables: 
 

The tables have four columns each and resemble the example table shown below: 

 
For numeric fields, the maximum amount of numbers allowed is represented on the table as a decimal. The number 
that precedes the decimal indicates how many numbers you may place before a decimal point and the number 
following the decimal represents how many numbers may follow the decimal point. 
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For example: If the number on the Field Restriction Table is 5.2. You may place five (5) digits before the decimal 
point and two(2) digits after the decimal point. The range of numbers available, in this particular case, is -99999.99 to 
99999.99. If you enter too many numbers in a field, your current record will not be saved. Instead, the offending field 
is highlighted and an error message appears in the lower left side of the Status Bar. 

Any key on the keyboard is considered a character, so you may place letters, numbers, and symbols in any 
CHARACTER field. You may enter as many characters as that field allows (this is represented as a whole number on 
the Field Restriction Table). If the field is categorized as DATE FORMAT, then you must use the proper date and 
time format that you have selected in your System Options. 

If a field is MANDATORY, it must be filled in before you can save a record. Power*Log / Core & CurveÊ uses these 
mandatory fields to identify records in the database. Therefore, if you have not filled in a mandatory field and you try 
to save the record, the offending field is highlighted and an error message appears in the lower left side of the Status 
Bar. 

Accessing the On-line Help System in Power*Log / Core & CurveÊ: 
 

You can make use of the context sensitive help by pressing the F1 key when you are in a dialog box. A pertinent help 
file will appear, opened to the topic relevant to the dialog box you are in. 
 

18BThe Toolbar 

 

19BThe Selection Baré 

 

20BThe Status Baré 

 
The Status Bar displays system status messages and any error message (associated with a field entry), 
in the far left corner. The KB elevation is displayed in the lower right corner of the Status Bar. 
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21BThe Import Toolbar 
This toolbar is dock able and can be moved to different places on the screen. 

The Power*Log / Core & CurveÊ Import Toolbaré 

 

22BThe Export Toolbar 
This toolbar is dock able and can be moved to different places on the screen. 

The Power*Log / Core & CurveÊ Export Toolbaré 

 

Button, Check box and drop box types. 

 

The Four (4) Main On-line Help System Categories: 

Commands - Descriptions of each menu command within Power*Log / Core & CurveÊ. 
Toolbar - Shortcuts to common commands are explained. 
Database Table Operations - Commands or functions related to the Database Table are described. 
Quick Reference Guide - The portion of the On-line Help System that quickly refers you to some of the more 
commonly performed tasks.
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0BChapter One - File Menu 

23BConnect 
Connects Power*Log / Core & CurveÊ to a database. 
To access the Connect Database window, click on Connect, under the File menu 

selection, or click on the  Connect button on the Toolbar. 

 
Connecting to a Database 

1. When this window is displayed, highlight the PGEOLOGY V11 METRIC {Microsoft Access Driver)*.mdb)] 
database.  

2. Enter your User ID and Password in their respective fields (your default User ID and Passwords are both 
"pgeology"). 

3. Click on the  button to complete the connection. 

24BDisconnect 
Disconnects Power*Log / Core & Curve Ê from a database. 

Disconnect  button on the Toolbar 

25BGrant Access 
The Grant Access window provides the Network Administrator and/or Power*Geology 
Superuser(displayed in the Granter field in the upper left corner of the Grant Access 
window), with the ability to control which network users gain access to specific well 
information or data residing within the Power*Geology network database. 
 
Granting Access to existing Grantees 

1. Click on Access Registration, under the File menu selection, and then click on Grant Access. 

 

This will activate the Grant Access window shown on the next page: 
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2. Select (highlight) the well(s) from the Granter's Well List field that you wish to give a specific Grantee or 
Grantees access to. 

3. Select (highlight) the Grantee(s) from the Grantees list field that will be given access to the well you 
selected earlier from the Granter's Well List field. 

4. Click once on the  button and you will receive the following system message, "Do you really 
want to GRANT access?" 

5. Click once on the  button to give the selected Grantee(s) access to the selected well(s). 

Note: Use PUBLIC, in the Grantees list field, to give ALL of the Grantees access to selected well(s). 

Granting Access to a new Grantee 

1. Click on Access Registration, under the File menu selection, and then click on Grant Access to activate 
the Grant Access window. 

2. Select (highlight) the well(s) from the Granter's Well List field that you wish to give the new Grantee access 
to. 

3. Type the name of the new Grantee into the New Grantee field. 

4. Click once on the  button and you will receive the following system message, "Do you really 
want to GRANT access?" 

5. Click once on the  button to give the new Grantee access to the selected well(s). 

Granting Access to a new well 

Note: Situations will arise in which existing Power*Log/Curve users have not yet been given access to a well that 

was recently or soon to be spudded. Accordingly, the Network Administrator and/or Power*Geology Superuser 

will use the UWI from the new well to grant access to the selected Grantee(s). 

1. Click on Access Registration, under the File menu selection, and then click on Grant Access to activate 
the Grant Access window. 

2. Type the UWI of the new well into the New Well (UWI) field. 
3. Select (highlight) the Grantee(s) from the Grantees list field that will be given access to the new well. 

4. Click once on the  button and you will receive the following system message, "Do you really 
want to GRANT access?" 

5. Click once on the  button to give the selected Grantee(s) access to the new well. 



                                 User Manual Version 11 
 

Chapter One- File Menu, Page 22 

26BRevoke Access 
The Revoke Access window provides the Network Administrator and/or Power*Geology Superuser (displayed in 
the Granter field in the upper left corner of the Revoke Access window), with the ability to revoke the access of 
specific network users to specific well information or data residing within the Power*Geology network database. 
 
Revoking Access to existing Granteesé 
 

1. Select Access Registration, under the File menu selection, and then click on Revoke Access to activate 
the Revoke Access window shown below: 

     

2. Select (highlight) a specific Grantee from the Grantees list field to determine what wells in the Grantee's 
Well List field the Grantee currently has access to. 

3. Select (highlight) the well(s) from the Grantee's Well List field you wish to revoke access to for the 
previously selected (highlighted) Grantee. 

4. Click on the Revoke Access (Grantee View) button and you will receive the following system message, 
"Do you really want to REVOKE the selected wells from the selected user?" 

5. Click on "Yes" to revoke the access of the selected Grantee to the selected well(s) in the Grantee's Well 
List field. 

 
Revoking Access to a selected well 
 

1. Select Access Registration, under File, and then click on Revoke Access to activate the Revoke Access 
window. 

2. Click on the Well Name button to activate the Well List window. 
3. Double click on the desired Well from the Well List window to display it in the Well Name and UWI fields 

within the Revoke Access window. 
4. Select (highlight) the Grantee(s) from the Grantees field for whom you wish to revoke access to the 

selected well. 
5. Click on the Revoke Access (Well View) button and you will receive the following system message, "Do 

you really want to REVOKE the selected users from the selected well?" 
6. Click on the ñYesò button to revoke the access of the selected Grantee(s) to the selected well displayed in 

the Well Name and UWI fields, respectively. 
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27BNew Log 

1. The first step in creating a new log is to click on the  New Log button on the Toolbar, or to select New 
from the File menu selection. This will open the New Log window shown below: 

                        

2. The Cursor will be active in the Well / Log Name field. Type in the Well Name into the Well / Log Name field 
(maximum of 50 characters). On a new well the well name and the log name will be the same. 

3. Click on the  button to activate the UWI Format window shown below: 

 

4. Select the Survey System from the Use drop box. The DLS (Dominion Land Survey) system format is for 
Alberta, Saskatchewan, Manitoba and some of BC. The NTS (National Topographic Survey) system is for 
most of BC. The Name selection is to be used for anything that doesn't fit into the DLS or NTS systems. Once 
your selection has been made, it is displayed in the drop box, and a flashing cursor is placed in the first 
appropriate field, awaiting your data entry. 

5. Type in your data and remember that you can press Tab to move to the next field and Shift+Tab to move 
backwards. 

6. Click on the  button when you have finished entering the UWI. An extended UWI is created by 
Power*Log / Core & Curve Ê from the many small boxes that you just filled in. You will now be in the New Log 
window again. 

7. Click on the button to activate the Log Format List window shown below: 

 



                                 User Manual Version 11 
 

Chapter One- File Menu, Page 24 

8. Click once on the format you wish to use for your log and then click on the button. You may also 
double click on the desired format, where upon you will be returned to the New Log window. 

Note: Log Formats with the letter "V" in front of their names are Vertical logs, and can only be used within 

Power*LogÊ. Log Formats with the letter "H" in front of their names are Horizontal logs, and can only be used within 

Power*CurveÊ. 

9. Double Click in the Log Start Depth field. This will highlight the Zero, and activate a flashing cursor. Type the 
depth at which you want your log to start. 

10. Once the information is entered, click on the  button.  

Note: This will initiate a New Log. During this process, the curves associated with the selected log format will be 

added and Add Curve windows may be activated for each curve within that log format. An example of an Add Curve 

window is shown below. 

 

11. Click on the  button for each Add Curve window and you will have just added curves to the 
database that are displayed on the layers with the same name. 

Note: You may edit any of the curveôs properties in the Add Curve window. For more information, see ñAdding 

Curvesò in Chapter Ten. 

12. You can now edit, or add information in the Well Header Information window. 
13. Select Well, under the Edit menu selection, to activate the Well window, shown below 

 



User Manual Version 11 
 

Chapter One - File Menu, Page 25 

14. Fill in the information you feel is necessary (the picture above is filled in to give you an idea of what is required), 

and then click on the  button to save any changes you have made to the database. 

Note: Some of the fields in the Edit Well window have character restrictions or mandatory requirements. 

Consequently, if any of these restrictions have been violated or if any requirements have not been met, the offending 

field will be highlighted, the nature of the problem will be displayed on the Status Bar (lower left hand corner of the 

screen), and you will be prompted with a system error message window.  

15. If the record has been successfully saved, click on the appropriate button when prompted with the Shortcut 
Options system window. 

 

208BStarting a New Log with an Existing Well 
An example of doing this would be to create a Horizontal Log presentation for an existing vertical well in the 
database. You would use the vertical presentation (either MD, SSL. or TVD) and when the well reached 90 degrees 
you would start up a Horizontal. Also you could have a wellsight sample log and then incorporate the Samples with 
the Wireline data to have a composite log presentation. 

1. The first step in creating a new log is to click on the  New Log button on the Toolbar or to 
select New, under the File menu selection, and the New Log window will be opened. 

                          

2. Click on the  button to view the wells in the database. Then, double click on the well of your choice 
to automatically fill in the UWI and Well/Log Name fields. The user can then modify the Well/Log Name field to 
suitably reflect the Log Format (Vertical or Horizontal), to be used to display the existing wellôs data. 

3. Type a name for your log in the Well/Log Name field (no more than 50 characters long). The original Log name 
will be viewed in the Log/Name field.  The Log name must be unique in the database.  The user must modify the 
name by adding / removing or creating a new name. 

Note: This does not change the well name; it only changes the log name. 

4. Click on the button to activate the Log Format List window. 

5. Click on the Log Format you wish to use for your log and then click on the  button. Alternatively, 
you can simply double click on the desired Log Format and you will be returned to the New Log window with 
your selection appropriately displayed. 

Note: Available Logs with the letter "V" in front of their names are Vertical logs and can only be used within 

Power*Log/CoreÊ. Likewise, Available Logs with the letter "H" in front of their names are Horizontal logs and can 

only be used within Power*CurveÊ. 

6. Double Click in the Log Start Depth field to highlight the numeral zero (0) and activate a flashing cursor. Then, 
type in the depth at which you want your log to start. 
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7. Once the information is entered, click on the  button. If you have associated an existing well with the 
log, you will be prompted with yet another system message, ñYou are about to create a new log for an 

existing well. Do you want to proceed?ò Click on the  button to confirm. 

Note: This will initiate a New Log. During this process, the curves associated with the selected log format will may be 

added in the form of Add Curve windows, for each curve within that log format, with their associated units and 

scales. 

8. Click on the  button for each Add Curve window and you will have just added curves to the 
database that are displayed on the layers with the same name in/on your log. 

209BHow to Change the API code or the Unique Well Identifier (UWI) 
 
This procedure will guide the user through the appropriate steps to change the API code or the UWI. 

1. Click on the Open Log button or select Open, under the File menu selection, to activate the Open 
Log window. 

 

2. Highlight the Well Name that you wish to change the UWI / API, in the Well List portion of the window, and 
the logs for that well will appear in the Log List portion of the window. Highlight or click on any of the logs 

available for that well in the Log List. Then, click on the  button and the selected well / log 
will open accordingly 

3. Click on the Well selection, located under the Edit menu selection on the Menu bar. This will activate the 
Well Window. 
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4. Click on the button in the Well window to activate the appropriate window shown on the next 
page: This window will be filled in with the original information when the Log / Well were first created. 

 

5. Click your mouse cursor into the appropriate fields either in the DLS section, NTS section or the name 
section and make the necessary changes. 

6. Click on the  button. 

7. Click on the  button. If the well record has been saved you will be prompted with a 4 option system 
message. 

8. Click on the  button. 

You have now successfully changed the UWI or API Code for a well. We have automated all the logs associated with 
the original Well to be reallocated with the new Wells UWI. For your information all data for a well is stored under the 
UWI and not the well name. 

28BOpen 
Opens an existing log 

Click on the  Open Log button or select Open, under the File menu selection, to activate the Open Log 
window. 
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1. Locate the well you wish to open either by querying or scrolling through the Well List portion of the window 
and Click on the Well Name so it becomes highlighted, and the logs available for that well will appear in the 
Log List portion of the window.  

2. Click on the log name you want to open. It will become highlighted. 

3. Click on the  button and the selected log will open accordingly. Please keep in mind that 
Power*Log / Core & CurveÊ allows you to have multiple logs open at once. 

The Recent Logs portion of the window indicates the last 10 logs / wells opened. You may wish to select one of 
these rather than looking through the well list. Also if you are reopening the last well used it is already highlighted in 

the Recent Logs list and can be reopened easily by clicking on the  button or by depressing your enter 
key on your keypad. 

Note: Logs with the letter "V" in front of their names are Vertical logs, and can only be used within Power*LogÊ or 

Power*CoreÊ. Likewise, Logs with the letter "H" in front of their names are Horizontal logs, and can only be used 

within Power*CurveÊ. 

210BHow to Sort the Well List 
(Well Name, UWI, Spud Date, Total Depth, Field, Pool, Hole Direction, Province/State, License #) 

1. Click on the  Open Log button or select Open, under the File menu selection, to activate the Open 
Log window. 
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2. The default sorting in the Open Log window is on Well Name. If you wish to sort on any other criteria, you 
simply have to click on its heading indicator at the top of the Well List. By doing so, you will sort the 
window with respect to that criterion. The Example above is sorted by spud date in ascending order. If you 
click on the heading indicator again it will reverse the order as shown in the example below with Spud date 
in descending order. 

 

211BHow to Query the Well List (By String Search) 

1. Click on the  Open Log button or select Open, under the File menu selection, to activate the Open 
Log window. 

  

2. Choose the field to search criteria by clicking on the drop arrow in the search portion of the window. This will 
activate a drop list and click on your selection. You have many field strings to search with. Then type in 
your search criteria in the Enter String field. The example shown above is any Well Name with ANY in it 
anywhere. 

3. You can choose a search type in the drop box beside the Search string you have type or selected. The 
default is like so if in this case the ANY can be anywhere in the well name. 

4. Click on the  button. This will redo the Well List with those Well Names that meet the specific 
criteria. The search results are shown below. 
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5. Click on the  button to refresh the list with all the Wells in the database. 

212BHow to Query the Well List (By DLS or NTS Survey Systems) 

1. Click on the  Open Log button or select Open, under the File menu selection, to activate the Open Log 
window. 

  

2. Type in the fields to search by utilizing either the DLS or NTS Survey system that was used to create the UWI. 
The example shown above is Township 84 Range 11 and the 6

th
 Meridian 

3. Click on the  button. This will redo the Well List with those Well Names that meet the specific 
criteria. The search results are shown below. 
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4. Click on the  button to refresh the list with all the Wells in the database. 

29BClose 
Closes the currently active log 

Click on Close, under the File menu selection, to close the current or active well or click on the  icon. 

Note: You do not have to save any changes prior to closing a log, because all work performed on a log is 

automatically saved to the Power*Geology database. 
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30BExport Log / Well 
Allows you to export log configurations, well information, system symbols and your Geology Expansion 
Dictionary 
 
Under the File menu selection, select Import / Export and then select Export Log / Well from the sub-menu. Or, you 

can click on the  Export button on the Toolbar. 
When you enter the Export window from the main Power*Log / Core & CurveÊ screen, the Export Log/Well 
window automatically defaults to the currently active log. 

    

1. Click on the  button to activate a list of logs in your database. Then, select the log for export by double 
clicking on it. 

2. If the log has a Primary Well associated with it, the Well field will default to the Primary Well. If there is no 

Primary Well or you wish to export a different well, select the well to be exported by clicking on the  
button to activate a list of the Wells available in your database. Then, double click on the well that you wish to 
export. 

3. The Log Configuration check box  should be activated (checked), when you are exporting a log for the first 
time or if you have changed the log's track or layer configurations. 

4. The Entire Well check box  should also be activated (checked), if you are exporting your well for the first time. 

Note: This is a good way to back-up your well's information and should be done on a daily basis, so that if your 

database becomes corrupted or your hard drive fails, you have a way to restore or recover your data. 

If you are transmitting your files to another location on a daily basis, the Entire Well check box  should be used 

until the file size (and resulting transmission time), becomes too large. After this point, it is recommended that you 

use the Morning Report check box , instead, to export only a portion of your well's morning data and should be 

used in conjunction with the Export Interval portions of the window, including Interval and Record Based Data. 

5. Activate the Today's Interval check box  and then enter a set of values into Today's Interval. 

Note: The values entered into Today's Interval, within the Export Log/Well window, will automatically be displayed 

in the Today's Section print interval part of the Print Log window when the log/well is imported. 

6. If you activated the Entire Well check box , please proceed to Step 11. 



User Manual Version 11 
 

Chapter One - File Menu, Page 33 

7. You may now also wish to activate the Morning Report check box   and then select a single date for export 

from the Morning Reports by clicking on the  button and then double clicking on the selected Date 
from the Morning Date From list window. 

8. To select a range of dates for export, however, simply click on the  button to activate the Morning Date 
To list window and then double click on the final Date to be exported. Then, every Date between this one and 
the one selected in Step 7 will then be exported. 

9. Enter the intervals of the Well that you wish to export in the Export Interval fields. After you have typed in the 
two (2) intervals, press the Tab key. This will cause the interval range you have just entered, to be displayed in 
the list window. The numbers you enter here will determine which Interval Based Data is exported. 

**Note that multiple interval ranges can be added to this interval list box. ** 

10. From the lists of Interval and Record Based Data, highlight the data that you wish to export. 

Note: If you are only exporting intervals, it is recommended that you choose the  buttons on the Interval and 

Record Based Data. 

 
If you are exporting a specific interval, your window should now look like the window shown below. 

 
Interval Based Data: 
Annotation: Any annotation on the log over the exported intervals. 
Date: The information in the Date layer of the well over the exported intervals. 
Detailed Lithology: The Detailed Lithology on the log over the exported intervals. 
Graphics: Any graphics inserted onto the log over the exported intervals. Theses graphic files can be pretty large so 
the user must be careful about sending these on a daily basis. 
Lithology: Includes all lithology-related tracks and layers over the exported intervals. 
Lithology Description: The Lithology Descriptions on the log over the exported intervals. 
MDT Runs: The information that is captured in the MDT Reports. 
NBR Symbology: The information that is captured on the core logs that have non bed restricted layers such as 
Trace Fossils, Bioturbation, Sedimentary Structures, Diagenesis, Fractures, Accessories. 
Oil Staining: The Oil staining data entered onto the log over the exported intervals  
Percent: Any of the Generic Percent Layers data. 
Sample / Core Descriptions: The Sample Descriptions you have entered into the Sample or Core Description 
Reports over the exported intervals. 
Slide / Rotate: The Slide / Rotate data entered onto the log over the exported intervals. 
Sneider Rock Type (G): The information in the Sneider Rock Type (Geo) layer of the well over the exported 
intervals. 
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Sneider Rock Type (C):  The information in the Sneider Rock Type (Core) layer of the well over the exported 
intervals. 
Record Based Data: 
Double click on Curves, Core, and Formation in the Record Based Data list to show a list of curves, cores, and 
formations. Highlight the specific curves, cores and formations to export them. To export all Curves, Cores, or 
Formations, just highlight "Curves," "Core," and "Formation." 

To add all data from a list, click on the  button located above the appropriate list. If you decide not to add any 

data from a list, click on the  button above the appropriate list. 
11. If you want to encrypt the file, enter the same password into the Password and Again fields. 
12. Type any comments about the file/well/log to be included with the export header information. 

13. Name the export file by clicking on the  button and then select a destination and a filename. 
Do not type in a file extension other than .EXP. If you omit the extension, an .EXP file extension will be 
added, automatically, to your filename by Power*Log, Core and CurveÊ. 

14. Click on the  button. 
 

Important Note: If your file is too large to fit on a floppy disk, you may have to export the file to your hard drive and 

then use a compression utility to fit the file onto a single disk. Common compression utilities include Microsoft 

Backup, PKZip by PKWare, and Norton Utilities. 

 
Also, if you have limited free hard disk space, you may not be able to save a file directly to a floppy, because 
Power*Log / Core & Curve Ê first writes data to the hard drive and then sends it to the floppy drive. 

213BExporting the Geological Expansion Dictionary, User defined 
Symbols or all your User defined Generic Category choice listé 
It is possible to export your geology dictionary, user defined symbols, or all your user defined generic category 
choices to another computer, so that any alterations you have made to the standard dictionary will translate properly, 
when you export logs to another location. 

1. In the Export window, select a file name for the exported version of your dictionary. Do this by clicking on 

the  button, and selecting a file name from your computer, or creating a new one. 

2. a.) Click on the  button and you will be prompted to verify the export. 

b.) Click on the  button and you will be prompted to verify the export. 

c.) Click on the  button and you will be prompted to verify the export. 

3. Click on the  button to export your selection. 
 

Important note: If you are importing a Geological Dictionary from another location, be sure to export your own 

Geological Dictionary to another directory or floppy, so that you will be able to access your own Geological 

Dictionary at a later time. Otherwise, your existing or original Geological Dictionary will be overwritten by the 

imported Geological Dictionary. 

 

Important note: If you are importing a System symbol set from another location, be sure to export your own 

System symbols to another directory or floppy, so that you will be able to access your own System symbol set at a 

later time. Otherwise, your existing or original System symbol will be overwritten by the imported System symbol. 

214BExporting all the Well Data at one timeé 
 

1. Select Import/Export, under the File menu selection, and then select Export Log/Well from the sub-menu.  

Or, you can click on the  Export Log / Well button on the Toolbar. 
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2. Click on the  button. This will activate a system message. 

 

3. Click on the  button. This will activate a Choose Directory window. You may wish to create a 
new folder for these well. This cannot be done from this window and must be done through Windows 
Explorer or My Computer. In the example an old wells folder is selected. 

 

 
 

4. Click on the drive and directory where you wish the well data to be exported to. Then, click on the 

 button. This will activate the Exporting window. 

 
5. When the export all well data is finished a System Message will be activated as shown below. Click on the 

 button. 
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215BExporting everything at one timeé 

This would include all the Well data, Generic Categories, Well Symbols, Geological Expansion Dictionary, 
Favorites and all the Power*Suite initialization files . 

1. Select Import/Export, under the File menu selection, and then select Export Log/Well from the sub-menu.  

Or, you can click on the  Export Log / Well button on the Toolbar. 

 

2. Click on the  button. This will activate a system message. 

 

3. Click on the  button. This will activate a Choose Directory window. You may wish to create a 
new folder for these well. This cannot be done from this window and must be done through Windows 
Explorer or My Computer. In the example an old wells folder is selected. 
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4. Click on the drive and directory where you wish the well data to be exported to. Then, click on the 

 button. This will activate the Exporting window. 

 

5. When the export all well data is finished a System Message will be activated as shown below. Click on the 

 button. Below you will view the folder created in the PowerSuite V10 \ Backup \ Todays 
backup with files and their names. 

 

    
 

You will notice that the well export will have the log names, and the other exports associated with this backup all 
feature will have a time stamp after the file type. 
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31BImport Log/Well 
Allows you to import a file into your database 

Select Import/Export, under the File menu selection, and then select Import Log/Well from the sub-menu. Or, you 

can use the  Import button on the Toolbar. This will activate the Import window 

      

Importing a Log/Wellé 

1. Click on the  button to browse through your drives/directories for the file(s) you wish to import. Note 
that files available for importing will have an .EXP file extension. Any of the files that you select will then be 
added to the File list. Please make sure that the files you wish to import are highlighted (selected), in the list prior 
to importing. 

Note: In situations where numerous Export files are all being imported at once, click on the button to 

highlight all of the Export files displayed in the Import window. 

2. If any of the files are encrypted, a window will appear, stating that the file format is not recognized (if the files are 

not encrypted, proceed to Step 5). Click on the  button in this window and a Password box will 
then appear with the filename and an empty field for you to enter the correct Password into. 

3. Type in the Password, using UPPERCASE letters only. 

4. After entering the Password, click on the  button to decrypt the file and place it in the File list with 
the file's contents displayed in the File Header list field. 

5. The Import Log/Well window will now be displayed with the details of the file(s) to be imported. Select/highlight 

the file(s) to be imported. Use the  button to select all of the files or use the  button to select 
none of the files. Note that you can select or turnoff individual files by simply clicking on them with your mouse. 

Note: The button will remove the selected/highlighted files from the import list, but will not delete 

them. The button, on the other hand, will completely erase the selected/highlighted files from their 

directory. Once deleted, these files will no longer be recoverable. 

6. Click on the button to activate the following system message, ñDo you really want to IMPORT 
the highlighted files?ò 

7. Click on the  button to proceed with the import. 
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Note: If you click on the ñYesò button, and the file you are importing contains the information from an Entire 

Well, the following system message will be activated, ñAbout to IMPORT ENTIRE WELL data. All information 

associated with this well in the database will be OVERWRITTEN. Continue?ò 

8. Click on the button. 
9. Upon completion of the import, the following system message will then be activated, ñData has been imported 

successfully.ò 

10. Click on the  button to confirm the successful import of the data. 

The button will take you to the Export Project/Well window. 

32BLAS Import 
Allows you to import Log ASCII Standard (LAS) formatted files into the database. We have separated these 
import procedures into 2 sections. The first section is How to Import an LAS data File. The second section is 
How to Import an LAS data file with a saved mapping file. 

The user can also import a single curve into an existing curve by referring to the Right Click import method. 

If the ASCII files you receive looks like the file shown on the next page it is an LAS file. The ASCII data can be 
directly imported into the database as long as the Well exists in the database. You can now proceed with ñHow to 
import an LAS data Fileò. If it does not look similar you will have to proceed with ñHow to Import an ASCII data fileò. 

~Version Information 
VERS.  2.00 :CWLS LOG ASCII STANDARD - VERSION 2.00 
 WRAP.  NO :One line per depth step 
~WELL INFORMATION 
#MNEM.UNIT  DATA   DESCRIPTION 
STRT.M   178.46040  :START DEPTH 
STOP.M   2206.44720  :STOP DEPTH 
STEP.M   0.15240   :STEP LENGTH 
NULL.   -999.22000  :Null value  
COMP.   ABC Exploration Company :Company 
WELL.   ABC et al Anywhere  :Well 
FLD.   Anywhere   :Field 
LOC.   111/09-12-015-5W4M :Location 
PROV.   Alberta   :Province 
DATE.   14-MAR-96  :Run Date 
UWI.   111012601505W400 :Unique Well ID 
LIC.   12356   :License Number 
SRVC.   Anywhere Logging Company :SERVICE COMPANY 
~CURVE INFORMATION 
#MNEM.UNIT  API CODE CURVE DESCRIPTION 
DEPT .M  00 001 00 00 : 1 Depth 
GR .GAPI  01 310 01 00 : 2 Gamma Ray 
DT .US/M  01 520 80 00 : 3 DELTA-T 
SP .MV  01 010 01 00 : 4 Spontaneous Potential 
LLD .OHMM  01 220 10 00 : 5 Latero-Log Deep (Resistivity) 
LLS .OHMM  01 220 09 00 : 6 Latero-Log Shallow (Resistivity) 
HD .MM  01 280 01 00 : 7 Hole Diameter 
TDEP .M  01 636 00 00 : 8 Tide Depth 
~PARAMETER INFORMATION 
#MNEM.UNIT  VALUE  DESCRIPTION 
RUN.   ONE  :Run Number 
PDAT.   GROUND LEVEL :Permanent Datum 
~OTHER INFORMATION 
#MNEM.UNIT  VALUE  DESCRIPTION 
~A  
DEPT    GR    DT     SP     LLD    LLS   HD   TDEP 
178.4604   52.4498   182.4146    96.9375    3.8158    0.1481    210.3713    178.46042 

If the well does not exist in your please refer to ñStarting a New Log/Wellò to create a new well so that you can import 
the curve data. 



                                 User Manual Version 11 
 

Chapter One- File Menu, Page 40 

216BHow to Import an LAS data File 
This method will allow you to import one or more curves into the database and your log. If the curve already exists in 
the database and is shown on a curve layer then the curve and itsô data will appear automatically on the log. If the 
curve does not exist the user must create a layer for that curve to be shown or replace an existing curve on an 
existing layer with a new curve. 

 
1. Click on the File pull down menu selection and click on Import / 

Export and then click on Import / Export LAS and then select 

LAS Import from the pop out-menu or simply click on the  
LAS button, on the Toolbar, to activate the LAS Reader 
window. 

2. This will then activate the Open window which allows the user to 
select the LAS file they wish to import the curve data from. Find 
the file and directory and highlight the file by click on it once and 

then click on the  button. If your log is open at the 
time you will see something similar to the window shown below. 

 
 

 

217BOverview of window 
The left hand side of the LAS Reader window allows the user to see the tree view of the data file format including 
the different data and information blocks. 
The right hand upper side of the LAS Reader window allows the user to see the data associated with the different 
data and information blocks. 
The right hand lower side of the LAS Reader window allows the user to see the curve names description and units 
for the curves as well as the curve layers associated with the log that is open and active at the time the LAS Reader 
window was invoked. 
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 Button allows the user to open another LAS file after the LAS Reader window has been 
opened. 

 Button allows the user to open another Log / Well to replace the curve layers with the new 
ones associated with a different Log / Well in the database. 

 Button allows the user to save the mapping between curves and layers when it has been done 
so that if you have to use a similar LAS file and/or a similar log format in the future. This enables the user to utilize the 
mapping that was done for the original so you do not have to repeat the clicking of dragging of curves to layers again 
and again if you do not want to. 

 Button allows the user to utilize the mapping file saved from above to remap the curves to 
layers. 

 Button allows the user to undo all the mapping from curves to layers that was done either by dragging 
or by utilizing the mapping file. 

 Check box will default the import to append the data. So it will check to see if the data exists and then 
will replace or append the data. If this is unchecked then the default will be replace which will delete the entire curve 
and replace the curve with the LAS data that will be imported. 

 Check box allows the user to import all the data in the file. If the box is 
unchecked then you can enter new from and to depths fields to import only a portion of the 
LAS data file 
If the box is unchecked then the user will have access to the top and base depths fields to 
type in an interval of data to import. This interval has do correspond to the lesser or equal to 
the depths corresponding in the data. 

 

218BImporting / Mapping of LAS Curve data. 
The log portion of the window must have a log open to directly map or import a curve to a particular layer. The LAS 
file must also be open on the left side of the window to view a list of curves to import. 

 
1. On the left side of the window Click and drag the curve you wish to import to the curve layer on the right 

side and release it when the layer becomes highlighted. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to 
replace. Note the legend of the mapping techniques. 

2. Repeat the Clicking and Dragging of curves to curve layers until all have been mapped. The user can also 
bring over new curves to the well without having a layer to show the curves on. You would then have to 
associate that curve to a new layer at a later date. This would be done through the log configuration builder 
on adding a new curve layer. 

3. The user can save this mapping procedure at this time by clicking on the  button and 
giving this procedure a file name and folder to be used again at a later date when you would have to import 
this data again. 

4. Click on the  button. You will then be prompted with a system message asking you 
if the actions done beforehand in the mapping procedure are correct. 
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5. Click on the  button if you wish to proceed with the import. You will view the processing 
going on in your status bar on the lower left of your screen. When the data is importing you will be prompted 
with a system message. 

 

6. Acknowledge the Finished Import message. Click on the  button and then click on the 

 to exit or click on the File menu and select the Exit option to close the LAS Reader Window. 

219BImporting LAS data with an Existing mapping file. 
The log portion of the window must have a log open to directly map or import a curve to a particular layer. The LAS 
file must also be open on the left side of the window to view a list of curves to import. 

 
1. On the middle portion between the LAS curve names and the curves from the open log click on the 

 button. This will activate an open file window. 

 

2. Select the mapping file with the *.cvm saved from previous imports  of similar data to similar logs. You may 
have some messages popping up indicating some of the possible errors that may have occurred. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to 
replace. Note the legend of the mapping techniques being performed. 

3. The user can map more curves on the left side of the window by Clicking and dragging the curve you 
wish to import to the curve layer on the right side and release it when the layer becomes highlighted. 

4. Click on the  button. You will then be prompted with a system message asking you 
if the actions done beforehand in the mapping procedure are correct. 

 

5. Click on the  button if you wish to proceed with the import. You will view the processing 
going on in your status bar on the lower left of your screen. When the data is importing you will be prompted 
with a system message. 



User Manual Version 11 
 

Chapter One - File Menu, Page 43 

 

6. Acknowledge the Finished Import message. Click on the  button and then click on the 

 to exit or click on the File menu and select the Exit option to close the LAS Reader Window. 
 

33BExport LAS Files 
The Power*Suite LAS Export Utility program can be accessed through the Power*Suite folder and facilitates 
the export of Power*Suite curve data into an LAS File. 
 
How to Export an LAS File 

1. Under the File menu selection, click on Import/Export, click on Import / Export LAS and then select LAS 
Import from the pop out menu. This will activate the LAS Export window. 

     

2. Click on the  button. This will activate a list of all the wells in your Database. 
3. Select the well you wish to export your LAS Curve data for by clicking on the well name and then clicking 

on the  button or by double click on the well. You should now see your well name in the 

field beside the  button. Also, you should see a list of curves in the Curve List field. An 
example of this is shown on the next page. 

4. Click on the  button and type in a file name and path for that file in the window. Click on the 

 button when you have done. 
5. Select the Curves you wish to create a file for by click on the curve name in the Curve name field or by 

clicking on the  button to select all the curves. 
6. Select the step type you wish to use for the export. 

Extrapolate will give you the best incremental data utilizing a constant step extrapolating the data to replicate this 

constant step. The Curve depths selection will merge the curves (if more than one curve is selected) and will export 

the data as it has been collected into the database. 

7. Type in an appropriate step (depth increment) or utilize the default 1 m depth increment. 
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8. Optional Type in an interval in the From and To fields and deselect the Extract Interval All check box if you 
wish to export just a portion of the curve data. 

9. Optional If the user wishes to Change Null Value. 

a. Click on the  button. This will activate a Null Value window. 

 

b. Type in another Null value if the default null value of ï999.25 is not what you want for a null value 

and then click on the  button. 
10. Optional Select the reverse direction check box if you want the data in descending order. 
11. Optional Select the depth unit values other than (MD) Measured Depth (default). Click on either radio button 

 beside the other such selections as (TVD) True Vertical Depth or (SSL) Subsea Level. 

 

12. Click on the  button. This will activate a LAS file generation window indicating which curves 
are being exported. Then the process amalgamates all the curve data into a single LAS File. When the file 
generation has been completed a System Message will be generated. 

There may be a message box encountered during this process indicating some of the curves selected have no data. 
You will have a choice of not including these curves in the LAS Export file. 

 

13. Once the File has been created acknowledge the ensuing message by clicking on the  
button. 

14. Click on the  button to Close the application or repeat steps 2-13 to create more LAS Curve 
data files. 
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34BImport Surveys New Method 
The new method will allow the user to import ASCII or csv file format into our database. We cannot import xls or any 
other type of spreadsheet format. If the data comes that way you must resave it in another format before attempting 
to import the data. If the data has not been formatted correctly and the ASCII file has any non numeric characters 
such as Easting (E) or Northing (N) the user should utilize the old method of importing. The older method only imports 
the measured depth inclination and azimuth columns. 

Importing Surveys  
 

1. To access the Directional Survey Import window, click 
on Import / Export under File to activate the pop-out 
menu and then select Import Surveys to activate a pop 

out menu and select New Method or click on the  
Import Survey button on the Toolbar. This will 
activate another pop out menu and select new method. 
This will open Directional Survey file window as shown 
below. 

 
 
 

2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set 
delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the Directional survey import window shown on the 
next page. 
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220BOverview of the window. 
The left hand side of the Directional Survey Point Import window allows the user to view the different data 
columns represented in the file numbered in ascending order. 
The right hand side of the Directional Survey Point Import window allows the user to see the data fields 
associated with the Directional Survey Table supplied by Power*Suite. 

Drop box allows the user to import the surveys into 
unique survey groups that have been made in the program. 

 Button allows the user to open another Survey file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
survey file to database fields in the survey point table in the database. 
 

 Button allows the user to save the mapping between data columns in the survey file to database 
fields in the survey point table in the database. Once the initial mapping has been done and saved, the user can 
utilize this mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in the 
survey point table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the survey file to 
database fields in the survey point table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Wordpad to look at the file format and possibly make 
changes to the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 
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221BImporting / Mapping of Survey data. 
The survey group must exist in the database to be able to import survey data. 

 
1. On the left side of the window Click and drag the data column you wish to import to the corresponding 

table field on the right side and release it when the field becomes highlighted. If mapped the field  will 
turn green on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 

2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 
mapped. 

 

N.B. The minimum requirement for us to calculate Minimum Curvature is the measured depth, Inclination and 
Azimuth and Measured Depth and Inclination for Drift Angle calculations. The user can import all the fields if they are 
available and no survey calculations are necessary unless you wish to update the well path or TVD fields in other 
windows. 

3. The user can save this mapping procedure at this time by clicking on the  button and giving 
this procedure a file name and folder to be used again at a later date when you would have to import this 
data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  

to exit or click on the  button to close the Window. 
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6. This will prompt the user with a System Message asking the user if they wish to calculate the TVD 

and Well Path Calculations. Click on the  button if you need to update the well path or TVD 
fields or if you imported only the minimum fields and do not have any TVD on the import. Click on the 

 button if you have all the information you require on the import. 

 

If you Clicked on the  button move ahead to page46. 

35BImport Surveys Old Method 
If the data has not been formatted correctly and the ASCII file has any non numeric characters such as Easting (E) or 
Northing (N) the user should utilize the old method of importing. This method is better because it only imports the 
measured depth, inclination and azimuth columns and does not read the rest of the file. 

222BImporting Surveys  
 

To access the Directional Survey Import window, click on Import / Export under File to activate the pop-out menu 
and then select Import Surveys to activate another pop out selection and select Old method. This will activate the 

Directional Survey Import window. Method or click on the  Import Survey button on the Toolbar. 
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1. Click on the  button, and select the data file provided by the directional drillers.  
2. The next step is to select which Survey Group you want to Import the surveys into. The Default is Group 1. 

If you wish to Import the surveys into a different group click on the button and then select 
the Survey Group form the List provided. 

3. The next step is to select the correct delimiter for your file. Select one from the right hand drop down box. 
When you have selected the correct delimiter for your file, the curves should fill the individual columns. 

4. From the top window, choose a start depth by clicking the first line of data you wish to import. 
5. Select the columns that represent the measured depth, Inclination and azimuth values from the drop down 

boxes on the right hand side of the columns. 

6. Click on the button. 
 

After a successful import, the directional surveys should contain the values of the measured depth, 

inclination and azimuth from the directional survey data file. 

 
The next thing will be a System message asking the user  
 

 
 

7. Click on the  button only if you have the required fields filled in within the Directional Survey 
Report window. Otherwise, you will not be able to calculate the surveys. 
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TVD Calculations  

The TVD Calculations window will perform either Minimum Curvature calculations if all the survey data has an 
azimuth or direction or can do Drift Angle calculations if the survey data only has a measured depth and an angle for 
both the Survey group imported into as well as the Master Survey group. This Master Survey group can consist of 
survey data from several groups of surveys that have been used throughout the drilling process. The Master Survey 
group must be chosen in the Directional Survey window. Also, this window we can update a Well path curve from the 
survey points in either TVD or SSL values starting at a desired measured depth. Also, if you would like to change or 
update any of the TVD fields scattered through the different report windows can also be done in this window.  
If a Master Survey group is built this survey data is utilized to perform all the TVD and SSL views for a specific well. 
This would only be applicable if there are multiple survey groups for a well and they cover different portions of the 
wells profile. 

 
Directional Survey Portion: 

The User has the ability to have the program calculate the Directional Survey group, select which survey group they 
wish to calculate, which calculation method either minimum curvature or drift angle calculations and from either tie-in 
or kick off co-ordinates. 
 
Procedureé 

1. If the user wishes to calculate a Survey Group, activate the Check box  in this portion of the window. 

2. If the default survey group is not correct, click on the button and select the survey group you 
wish to calculate from the List. 

3. Select the Calculation method from the drop box. (Minimum curvature must have an azimuth and will fill in 
all the fields in the Survey Points Window, otherwise use drift angle to get only the TVD field completed in 
the Survey Points Window.) 

4. Select the From Tie-In or Kick-Off co-ordinantes 

The defaults are picked up from the User defined TVD Calculation portion of the óDirectional Surveys Reportô, found 

under the Reports menu selection. Kick Off is selected by default if not filled in. Remember that the data required for 

the Kick Off or Tie In reference is entered in the óDirectional Surveys Reportô, found under the Reports menu 

selection.  Kick Off is selected by default. 

Calculate Master Survey Portion: 

The User has the ability to have the program calculate the Directional Surveys in the Master Survey group, which 
calculation method either minimum curvature or drift angle calculations and from either tie-in or kick off co-ordinates. 
The Master Survey Group can be compiled from points from different Survey Groups. The Master Survey group is 
built in the Directional Survey window. If there is only one survey group this procedure is not required. The Master 
Survey group if built is then used to perform all TVD / SSL Calculations within the application. 

Procedureé 

1. Select the Calculation method from the drop box. (Minimum curvature must have an azimuth and will fill in 
all the fields in the Survey Points Window, otherwise use drift angle to get only the TVD field completed in 
the Survey Points Window.) 

2. Select the From Tie-In or Kick-Off co-ordinates. 

Well Path Portion: 
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The Well Path for lack of better terms will update any curve on your log with either TVD or SSL data and will start at 
any depth required. It basically plots a curve with respect to measured depth and the survey dataôs TVD calculations 
which can also be converted to SSL if a KB elevation has been entered into the Well Record located under the Edit 
menu selection. 

Procedureé 

1. If the user wishes to calculate or update the Well path curve activate the Check box  in this portion of 

the window. 

2. Select which curve you wish to populate with this data by clicking on the button and 
selecting the curve from the existing curve in the database. 

3. Type in the Start depth for which the curve will first appear on the log. 
4. Select which units you would like this curve to be plotted or updated with from the Units selection box. TVD 

is the direct calculations from the survey points. SSL are converted with respect to the wells Kelly Bushing 
Elevation. 

TVD Attributes Portion 

Procedureé 
 

1. If the user wishes to calculate or update the specified TVD fields within the various windows throughout the 

Reports activate the Check box  in this portion of the window. 

The program is only able to determine the TVD at any depth covered by the directional surveys. Power*Log and 
Power*Curve have several windows in which the measured depth and corresponding true vertical depth are asked 
for. If you have directional surveys over that interval, the program will calculate the exact TVD for you. If it is outside 
the range of your surveys, it will be left as a manual entry. 

2. Select or click on which fields (highlight) you wish to calculate for or recalculate if you have changed the 
survey data. Remember you have the ability to select all or unselect all. 

3. Click on the  button. 

223BHow to Import a Survey Data with an Existing mapping file. 
1. To access the Directional Survey Import window, click on Import / Export under File to activate the pop-out 

menu and then select Import Surveys or click on the  Import Survey button on the Toolbar. This will 
activate the open Directional Survey file window as shown below. 

 
2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set 
delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  
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3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the Directional survey import window shown on the 
next page. 

 
 

4. In the upper portion of the window click on the  button. This will activate an open file window. 

 

5. Select the mapping file with the *.dsm saved from previous imports of similar survey data files to your 

directional survey table by highlighting the file and clicking on the  button or double clicking 
on the file name. Once the file has been opened  it will refresh with the current mapping configuration as 
shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the column 
you wish to import to the field on the right side and release it when the layer becomes highlighted. 

 

7. Click on the  button. After the data has been imported you will be prompted with a system 
message. 
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8. Acknowledge the Import message. Click on the  button and then click on the  

to exit or click on the  button to close the Window. 

9. This will prompt the user with a System Message asking the user if they wish to calculate the TVD and Well 

Path Calculations. Click on the  button if you need to update the well path or TVD fields or if 

you imported only the minimum fields and do not have any TVD on the import. Click on the  
button if you have all the information you require on the import. 

 

36BExport Surveys 
This utility exports your survey data into 3 file formats which can then be used by other applications. 
 
Exporting Surveys  
 
To access the Export Directional Surveys window, click on Import / Export under File to activate the pop-out menu 
and then select Export Surveys. This will activate the Export Directional Surveys window. 
 

     
 

1. Click on the Choose Survey Group drop down arrow and select a survey group. 
2. Click on the radio button next to the type of the file that you would like to create. 

3. Click on the  button. This will activate a Specify Survey Export File Name window. 
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4. Type in a file name and select the drive and directory you wish the survey to be exported to. Then, click on 

the  button. This will activate the System Information window asking you if you wish to 
proceed. 

 

 
 

5. Click on the  button. This will activate the Survey Export File Created window. 
 

 

6. Click on the  button and then click on the  button to exit Export Directional 
Surveys window. 

224BImport AGS (Only relative to Apple Core Data files that are Version 
9.2D) 

37BImport Core Plug Data  
This method will allow the user to import ASCII or csv file formats into our database. We cannot import xls or any 
other type of spreadsheet format. If the data comes that way you must resave it in another format before attempting 
to import the data. 

225BHow to import Core Plug data 
1. To access the Core Plug Import window, click on Import / Export under File to activate the pop-out menu 

and then select Import Core Data or click on the  Import Core Data button on the Toolbar. This will 
activate the open Core Plug data file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once on the file name and click on the  button. This will 
activate the Set delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the Directional survey import window shown on the 
next page. 

 

226BOverview of the window. 
The left hand side of the Core Plug Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Core Plug Data Import window allows the user to see the data fields associated with the 
Core Plug Data Table supplied by Power*Suite. 

 Button allows the user to open another Core Plug data file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
survey file to database fields in the survey point table in the database. 
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 Button allows the user to save the mapping between data columns in the survey file to database 
fields in the Core Plug table in the database. Once the initial mapping has been done and saved, the user can utilize 
this mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in the 
survey point table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the survey file to 
database fields in the survey point table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Wordpad to look at the file format and possibly make 
changes to the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 

227BImporting / Mapping of Core Plug data. 
 

1. On the left side of the window Click and drag the data column you wish to import to the corresponding 

table field on the right side and release it when the field becomes highlighted. If mapped the field  will 
turn green on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 

2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 
mapped. 

 

3. The user can save this mapping procedure at this time by clicking on the  button and giving 
this procedure a file name and folder to be used again at a later date when you would have to import this 
data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system 
message. 
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5. Acknowledge the Import message. Click on the  button and then click on the  

to exit or click on the  button to close the Window. 

228BHow to Import Core Plug Data with an Existing mapping file. 
1. To access the Core Plug Import window, click on Import / Export under File to activate the pop-out menu 

and then select Import Core Data or click on the  Import Core Data button on the Toolbar. This will 
activate the open Core Plug data file window as shown below. 

 
2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once on the file name and click on the  button. This will 
activate the Set delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the Directional survey import window shown on the 
next page. 

4. In the upper portion of the window click on the  button. This will activate an open file window. 

 

5. Select the mapping file with the *.cdm saved from previous imports of similar core data files to your core 

plug table by highlighting the file and clicking on the  button or double clicking on the file 
name. Once the file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 
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6. The user can map more data columns on the left side of the window by Clicking and dragging the column 
you wish to import to the field on the right side and release it when the layer becomes highlighted. 

 

10. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

11. Acknowledge the Import message. Click on the  button and then click on the  

to exit or click on the  button to close the Window. 

38BASCII Import - How to Import an ASCII data file  
This method will allow you to import one or more curves into the database and your log. If the curve already exists in 
the database and is shown on a curve layer then the curve and itsô data will appear automatically on the log. If the 
curve does not exist the user must create a layer for that curve to be shown or replace an existing curve on an 
existing layer with a new curve. 
 
This method will allow you to import one or more curves into the database. However, right click method may be 
easier if you only have one curve to import. Refer to page 9 within chapter 10  
Also refer to Right Click ASCII Import Method.  
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1. Click on the File pull down menu selection and click on Import / Export 
and then click on ASCII Import from the pop out-menu or simply click 

on the  ASCII Import button, on the Toolbar, to activate the ASCII 
Import window. 

 
2. This will then activate the Open window which allows the user to select 

the ASCII file they wish to import the curve data from. Find the file and 
directory and highlight the file by clicking on it once and then click on 

the  button. This will prompt you with a Set delimiter 
window as shown below. If you see <column break> between the data 
columns the delimiter is set correctly. 

Correct  Not correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the ASCII Import window shown below. 

 

229BOverview of window 
The left hand side of the ASCII Curve Import window allows the user to see the ASCII file data columns. The first 
data column has been defaulted to the depth column and has been given a purple color. 
The right hand side of the ASCII Curve Import window allows the user to see their log and the curve layers 
associated with the log that is open and active at the time the ASCII Curve Import window was invoked. 

 Button allows the user to open another ASCII file after the ASCII Curve Import window has been 
opened. 
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 Button allows the user to save the mapping between curves and layers when it has been done so that 
if you have to use a similar ASCII file and/or a similar log format in the future. This enables the user to utilize the 
mapping that was done for the original so you do not have to repeat the clicking of dragging of curves to layers again 
and again if you do not want to. 

 Button allows the user to utilize the mapping file saved from above to remap the curves to layers. 

 Button allows the user to undo all the mapping from curves to layers that was done either by dragging 
or by utilizing the mapping file. 

 Check box will default the import to append the data. So it will check to see if the data 
exists and then will replace or append the data. If this is unchecked then the default will be replace which will delete 
the entire curve and replace the curve with the ASCII data that will be imported. 

 Button allows the user to open the file in Wordpad to look at the file format and possibly make 
changes to the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 
 
Drop box allows the user to determine which column is the 
depth column in the data file. When it is chosen the color of 
the curve will change to purple. 
 

230BImporting / Mapping of ASCII Curve data. 
The log portion of the window must have a log open to directly map or import a curve to a particular layer. The ASCII 
file must also be open on the left side of the window to view a list of curves to import. 

 
1. On the left side of the window Click and drag the data column you wish to import to the curve layer on the 

right side and release it when the layer becomes highlighted. 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to 
replace. Note the legend of the mapping techniques. 

2. Repeat the Clicking and Dragging of curves to curve layers until all have been mapped. The user can also 
bring over new curves to the well without having a layer to show the curves on. You would then have to 
associate that curve to a new layer at a later date. This would be done through the log configuration builder 
on adding a new curve layer. 
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3. The user can save this mapping procedure at this time by clicking on the  button and giving 
this procedure a file name and folder to be used again at a later date when you would have to import this 
data again. 

4. Click on the  button. If done successfully you will be prompted with a System Message indicating 
Import done successfully as shown below. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  

to exit or click on the  button to close the ASCII Curve Import Window. 

231BImporting ASCII Curve data with an Existing mapping file. 
The log /well must be open for you to import ASCII Curve data into the well. 

 
1. Click on the File pull down menu selection and click on Import / Export and then click on ASCII Import 

from the pop out-menu or simply click on the  ASCII Import button, on the Toolbar, to activate the 
ASCII Import window. 

2. This will then activate the Open window which allows the user to select the ASCII file they wish to import the 
curve data from. Find the file and directory and highlight the file by clicking on it once and then click on the 

 button. This will prompt you with a Set delimiter window as shown below. If you see <column 
break> between the data columns the delimiter is set correctly. 
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Correct  Not correct  

3. Click on the correct delimiter radio button. Click on the  button. If your log is open at the 
time you will see something similar to the window shown below. 

4. Click on the  button This will activate a open ASCII Curve Mapping file dialogue window. 
Select the correct or previously saved *. acm file saved from previous imports of similar data to similar logs 

by highlighting the file and clicking on the  button or double clicking on the file name. 

 

N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from append to 
replace. Note the legend of the mapping techniques being performed. 

5. The user can map more curves on the left side of the window by Clicking and dragging the curve you 
wish to import to the curve layer on the right side and release it when the layer becomes highlighted. 

6. Click on the  button. If done successfully you will be prompted with a System Message indicating 
Import done successfully as shown below. 

 

7. Acknowledge the Import message. Click on the  button and then click on the  

to exit or click on the  button to close the ASCII Curve Import Window. 

39BImport Dip Meter Data 
This method will allow the user to import ASCII, space, comma or tab delimited file formats into our database. We 
cannot import EXCEL or any other type of spreadsheet format. If the data comes that way you must resave it in 
another format before attempting to import the data. 

Importing Dip Meter Data 
 

1. To access the Dip Meter Import window, click on Import / Export under File to activate the pop-out menu 

and then select Import Dip Meter or click on the   Import Dip Meter data button on the Import 
Toolbar. This will activate the open Dip Meter Data file window as shown below. 
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2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set 
delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the Dip Meter Data Import window shown on the 
next page. 
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232BOverview of the window. 
The left hand side of the Dip Meter Data Import window allows the user to view the different data columns 
represented in the file numbered in ascending order. 
The right hand side of the Dip Meter Data Import window allows the user to see the data fields associated with the 
Dip Meter Table supplied by Power*Suite. 

Drop box allows the user to import the dip data into unique dip 
meter groups that have been made in the program. 

 Button allows the user to open another Dip meter file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the dip 
meter file to database fields in the dip meter table in the database. 

 Button allows the user to save the mapping between data columns in the Dip meter survey file to 
database fields in the Dip meter table in the database. Once the initial mapping has been done and saved, the user 
can utilize this mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in 
the dip meter table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the dip meter file to 
database fields in the dip meter table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Wordpad to look at the file format and possibly make 
changes to the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 
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233BImporting / Mapping of Dip Meter data. 
A Dip Meter Layer should already have been added through the Log configuration builder so that a Dip Meter group 
exists in the database to be able to import Dip Meter data. 

 
1. On the left side of the window Click and drag the data column you wish to import to the corresponding 

table field on the right side and release it when the field becomes highlighted. If mapped the field  will 
turn green on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 

2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 
mapped. 

 

3. The user can save this mapping procedure at this time by clicking on the  button and giving 
this procedure a file name and folder to be used again at a later date when you would have to import this 
data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window. 



                                 User Manual Version 11 
 

Chapter One- File Menu, Page 66 

234BHow to Import Dip Meter Data with an Existing mapping file. 
1. To access the Dip Meter Data Import window, click on Import / Export under File to activate the pop-out 

menu and then select Import Dip Meter or click on the  Import Dip Meter button on the Import 
Toolbar. This will activate the open Dip Meter Data file window as shown below. 

 

2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set 
delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the Dip Meter Data Import window shown on the 
next page. 

4. In the upper portion of the window click on the  button. This will activate an open file window. 

 

5. Select the mapping file with the *.dmm saved from previous imports of similar dip meter data files to your dip 

meter table by highlighting the file and clicking on the  button or double clicking on the file 
name. Once the file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the column 
you wish to import to the field on the right side and release it when the layer becomes highlighted. 
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7. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

8. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window. 
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40BImport Modular Dynamic Tester (MDT) Data 
This method will allow the user to import ASCII, space, comma or tab delimited file formats into our database. We 
cannot import EXCEL or any other type of spreadsheet format. If the data comes that way you must resave it in 
another format before attempting to import the data. 

Importing MDT Data  
 

1. To access the MDT Data Import window, click on Import / Export under File to activate the pop-out menu 

and then select Import MDT or click on the   Import Dip Meter data button on the Import Toolbar. 
This will activate the open MDT Data file window as shown below. 

           
2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set 
delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the MDT Data Import window shown on the next 
page. 
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235BOverview of the window. 
The left hand side of the MDT Data Import window allows the user to view the different data columns represented 
in the file numbered in ascending order. 
The right hand side of the MDT Data Import window allows the user to see the data fields associated with the Dip 
Meter Table supplied by Power*Suite. 

Drop box allows the user to import the dip data into unique MDT 
groups that have been made in the program. 

 Button allows the user to open another MDT data file after the Import window has been opened. 

 Button allows the user to utilize the mapping file saved from above to remap data columns in the 
MDT data file to database fields in the MDT table in the database. 

 Button allows the user to save the mapping between data columns in the MDT data file to database 
fields in the MDT table in the database. Once the initial mapping has been done and saved, the user can utilize this 
mapping file so you do not have to repeat the clicking of dragging of data columns to database fields in the dip meter 
table again and again if you do not want to. 

 Button allows the user to undo all the mapping from data columns in the dip meter file to 
database fields in the MDT table that was done either by dragging or by utilizing the mapping file. 

 Button allows the user to open the file in Wordpad to look at the file format and possibly make 
changes to the data file prior to importing the files data. 

 Button reloads the data into the sample portion of the file window. 
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236BImporting / Mapping of MDT data. 
An MDT Layer should already have been added through the Log configuration builder so that an MDT group exists in 
the database to be able to import MDT data. 

 
1. On the left side of the window Click and drag the data column you wish to import to the corresponding 

table field on the right side and release it when the field becomes highlighted. If mapped the field  will 
turn green on the right and red on the left. 

N.B. The user can Right click on the Field to remove the mapping. 

2. Repeat the Clicking and Dragging of data columns to fields until all the columns that you want have been 
mapped. 

 

3. The user can save this mapping procedure at this time by clicking on the  button and giving 
this procedure a file name and folder to be used again at a later date when you would have to import this 
data again. 

4. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

5. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window. 
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237BHow to Import MDT Data with an Existing mapping file. 
1. To access the MDT Data Import window, click on Import / Export under File to activate the pop-out menu 

and then select Import MDT or click on the  Import  MDT button on the Import Toolbar. This will 
activate the Open MDT Data file window as shown below. 

 

2. Select the file from the folder or drive with the corresponding navigational tools provided and either double 

click on the file name or click once and click on the  button. This will activate the Set 
delimiter window as shown below. 

N.B. The one on the left the delimiter is set correctly the one on the right the delimiter is set incorrectly. 

Correct  Not Correct  

3. Highlight the correct corresponding  button beside Comma, TAB or Space delimiter (if shown correctly 
the Example should read <column-break> between the data columns. If you see this then click on the 

 button to close this window and activate the MDT Data Import window shown on the next 
page. 

4. In the upper portion of the window click on the  button. This will activate an open file window. 

 

5. Select the mapping file with the *.mdt saved from previous imports of similar MDT data files to your dip 

meter table by highlighting the file and clicking on the  button or double clicking on the file 
name. Once the file has been opened it will refresh with the current mapping configuration as shown below. 

N.B. The user can Right click on the Field to remove the mapping. 

6. The user can map more data columns on the left side of the window by Clicking and dragging the column 
you wish to import to the field on the right side and release it when the layer becomes highlighted. 
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6. Click on the  button. After the data has been imported you will be prompted with a system 
message. 

 

7. Acknowledge the Import message. Click on the  button and then click on the  to exit or 

click on the  button to close the Window. 

238BExport INI Settings 

This will allow the user to export all the userôs favoritesô lists, the placement of the toolbars, window placements and 
default settings for another user to import to have all the settings the original user has set up. 

239BExporting INI Settings 
 

1. To access the INI Export window, click on Import / Export under File to activate the pop-out menu and then 
select Export INI Settings. This will activate the Export INI Settings file window as shown below and tells 
you the folder it has been saved into as IBF file extension. 



User Manual Version 11 
 

Chapter One - File Menu, Page 73 

    

240BImport INI Settings 

This will allow the user to import all the userôs favoritesô lists, the placement of the toolbars, window placements and 
default settings from another user who has exported this file and to have all the settings the original user has set up. 

241BImporting INI Settings 
 

1. To access the INI Import window, click on Import / Export under File to activate the pop-out menu and then 
select Import INI Settings. This will activate the Open INI Backup file Settings file window as shown below. 

    

2. Select the file that has been exported and click on the  button. This will result in a system 
message that the file has been imported successfully as shown below. 
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41BASCII Export 

242BASCII Lithology Export 
This utility will create ASCII files, or comma delimited files of certain lithology data types (other than curves) for any 
well in the database. The utility can create a single file of the chosen data categories or multiple files with the same 
file name entered and their own file extensions. The file types and file extensions are listed at the end of this section. 

 
1. The first step in creating an ASCII or comma delimited file(s) is to select ASCII Export from the File menu 

selection. Then, select ASCII Lithology Export from the ensuing pop-out menu. Then, select the file format 
you wish to export the data into. We have tailored our ASCII files to be compatible with Landmark. This will 
activate the ADCII Lithology Export window. 

 
2. The user can select the file format for the ASCII Lithology export by clicking on the Select Output format 

arrow and selecting the file from the output list. This will place your selection in the file format field. 

3. Click on the  button to activate the Well list window. This will activate the Well List window. 
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4. Select the well by double clicking on the Well Name / UWI that you wish to make a Lithology ASCII dump 

for. The user can also click on the Well Name / UWI to highlight it and then click on the  
button. This selection will then be populated in the Well field in the Log Dump window. 

5. Click on the  button and this will activate the Choose filename window. 

 
6. Type in a file name and select the drive and directory you wish the file(s) to be exported to. Then, click on 

the  button. This will fill in the Choose file field in the Log Dump window with the drive, 
directory and file name. 

7. Select the data types you wish to populate your ASCII lithology export file(s) with by clicking on them once 
to make them highlighted. The user can deselect the data types by clicking on them again. Also, the user 

can click on the  button to select all the data categories or click on the  button to 
clear all your selections. 

8. If you want only one data type in each file created click on the Save as multiple files check box . If 
deselected or unchecked the dump will populate a single file. 

 

9. Click on the  button to initiate the export. This will activate a System Message. 

 

10. Click on the  button to acknowledge the message. 

11. Click on the  button to escape the Log Dump window or repeat steps 3-6 to create another set 
of ASCII Data Files. 

List of multiple files exported if file name that was used was dump 

Bedding Contacts dump.bdc 
Carbonate Texture Matrix dump.cbm 
Carbonate Texture dump.cbt 
Core Box Data dump cbx 
Diagenesis dump dg1 
Diagenesis - NBR dump dg2 
Dip Meter Data dump.dip 
Fractures dump.fr1 
Fractures - NBR dump.fr2 
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Framework dump.fwk 
Generic Fills dump.gsf 
Grain Size dump.gsz 
Grain Size Matrix dump.gsm 
Lithology dump.ilg 
Lithology Interbeds dump.itb 
Lithology Rock Accessories dump.acc 
Oil Shows dump.oil 
Oil Stains dump.stn 
Percents dump.pct 
Porosity Grade dump.por 
Porosity Type dump.pty 
Rock Accessory Symbols dump.nra 
Rock Accessory Symbols - NBR dump.brs 
Rounding dump.rnd 
Sample Descriptions dump.dsc 
Sedimentary structures dump.nss 
Sedimentary structures - NBR dump.brs 
Sidewall Cores dump.swc 
Sneiderôs Permeability - Core dump.snc 
Sneiderôs Permeability - Geo  dump.nss 
Sneiderôs Permeability ï Geo - NBR dump.brs 
Sorting dump.srt 
Trace Fossils  dump.nfs 
Trace Fossils - NBR dump.brs 
NBR = Non Bed Restricted  

243BSlide / Rotate Export 
This utility will create an ASCII file, or a comma delimited file for the slide rotate intervals of the log / well that is active 
at the time of the export. 
 

1. The first step in creating an ASCII or a comma delimited 
file is to select ASCII Export from the File menu 
selection. Then select the Slide / Rotate Export from the 
ensuing pop-out menu. This will open the Specify File 
Name window. 

2. Type in a file name (without extension) and select the 
drive and directory you wish the file to be exported to. 

Then click on the  button. This will 
activate a System Info ï Slide / Rotate Extract window. 

3. The System Info ï Slide / Rotate Extract Window will 
notify you that a file called (file name from step 2) will be 
create in directory (directory specified in step 2). Do you 

wish to proceed? Click on the  button to 
initiate the export. 

4. The file will be found in the location where was directed 
and can be opened in notepad / wordpad or into an Excel 

spreadsheet. 

244BExport ASE Format 
This utility will create dbl files, or comma delimited files of certain lithology data types (other than curves) for any well 
in the database. The utility can create a single file of the chosen wells or multiple files with the file name resulting 
from the well names. 

 
1. The first step in creating a dbl file format is to select ASCII Export from the File menu selection. Then, select 

Export ASE Format from the ensuing pop-out menu or by utilizing the Export DBL  icon on the toolbar. This 
will activate the DBL Export window. 
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2. Click on the Well Names to highlight or activate the Wells in the list. Click on them again to deselect from the list.  
Hold down the Shift key to access multiple wells or the CTRL Key to single out wells. 

3. Click on the  button and this will activate the Save DBL Export File window. 

 
4. Type in a file name and select the drive and directory you wish the file(s) to be exported to. Then, click on 

the  button. This will fill in the field in the DBL Export window with the drive, directory and file 
name. 

5. If you want only one well per file created click on the Multiple files check box . If deselected or 
unchecked the Export will populate a single file. 

6. Click on the  button to initiate the export. This will activate a System Message. 

 

7. Click on the  button to acknowledge the message. 

8. Click on the  button to escape the Export DBL window or repeat steps 2-7 to create another set 
of DBL Data Files. 

 

42BBackup 
Power*Log / Core & CurveÊ allows you to create a backup file of your active well or any other well you 
choose. 
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Creating a Backup of a Wellé 
 

1. With the well open at the time, Click on Backup, under the File menu 
selection, to activate the Backup To window. 

     

2. Select the directory to which you wish to send your backup file:  The 
C:\Powersuite_V11\Backup directory is created by Power*Log / Core & 
CurveÊ for the backup files, while the A:\ and B:\ drives represent the floppy 
drives on your computer. 

3. Click on any one of the directories to activate the Export window shown on 
the next page. 

 

Notice that the Export window automatically activates the Log Configuration and the Entire Well check boxes  
to ensure that all of your data is backed-up properly. 
 

Note: If you had a log open and active, when you began the backup steps, please proceed to Step 7. 

 
4. If you closed your log before exiting from Power*Log / Core & CurveÊ and you wish to make a backup, 

you will have to select a log and a well to back up. To do this, simply click on the  button to 
activate the Open Log window. 
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5. Then, double click on the Available Log you wish to back up and the Export window will be filled in 
accordingly. 

6. Click on the  button to begin the backup procedure. Note that the backup file will 
automatically be given a file name, based on the date and the number of times you have backed up wells in 
one day. The example shown in the Export window above is for May 5, 2000 and was the second backup of 
that day. 

7. The following message then appears, ñData has been exported successfully.ò Click on the  
button to proceed. 

8. Press the Esc key on the keyboard to exit from the Export window or click on the button. 

43BPrint Log 
Prints all or part of your log/well along with the Title page, legends, individualized cores and formation tops 
on a continuous or single sheet basis 

1. Under the File menu selection, click on Print Log or click on the  Print button on the Toolbar to 
activate the Print Log window shown below: 

Note: The Title bar and all depths associated with the Print Log window are defaulted to the Depth View that 
Power*Log or Power*Curve are in at the time of the activation of the Print Log window. 

 

2. Select the appropriate paper orientation from this drop box 
field and the Title Page, Legend, and Formation Tops will automatically conform to the selected 
orientation. There are four (4) types of paper orientation to choose from: letter portrait or landscape and 
legal portrait or landscape settings. 



                                 User Manual Version 11 
 

Chapter One- File Menu, Page 80 

Note: The letter or legal landscape or portrait settings selected from within the Print Log window will NOT override 

the paper orientation settings selected in the printer's Properties window. Therefore, you must also modify the paper 

orientation settings in your printer's Properties window to letter or legal landscape. 

3.  Activate this check box , if you wish to printout a full Wellsight Version of the Title 
Page. 

4.  Activate this check box , if you wish to printout an abbreviated version of the Core 
Log Title Page. 

5.  Activate this check box , if you wish to printout an abbreviated version of the 
Core Log alternate title Page. 

6.  Activate this check box , if you wish to printout an abbreviated version of the 
Sample Log Title Page. 

7. Activate this check box , if you wish to printout a logo, and then select a logo 
from the Logo drop box field. 

 
 

Note: Any bitmap image may be printed out as a logo. However, the bitmap image must be an equally sided square 
image, because Power*Suite will shrink or expand the image to fit the logo space on the Title Page. This bitmap 
should be placed in the Powersuite_V9\logo directory. 

8. Type any pertinent comments into the Title Page Remarks field and they will be displayed accordingly on 
the Strip Log Title Page only. 

9.  Activate this check box , if you wish to have our entire legend printed out. 

10.  Activate this check box , if you wish to have the legend reflect only the symbols 
printed on the log or core portions of the printed intervals defined in the log and core portions of the 
print log window. 

In the Log portion of the Print Log window 

11. Select or type in the Scale for the main log to be printed out at, in the Scale drop 
box field. 

12.  Activate this check box  to have the track headers printed out with the main log. 

13.  Activate this check box  to have the track footers printed out with the main log. 

14.  Activate this check box  to have the core accessories printed out on the main log. 
15. Highlight the main log printing options in the selection box. The user 

can select either None, User-defined Interval (requires that you 
manually enter the desired print interval depths), Today Section, 
Well Section, or Lithology Section. 

 
 

Note: Today Section interval is derived from the From and To Depth values entered into the Todayôs Section 

portion of the Power*Log Data Transfer: Export window. 

The Well Section interval is derived from the Top and Base Depth values entered into the Print Sections window 

(see Print Sections). 

The Lithology Section interval is derived from what has been drawn into the interpretive lithology track of the well 

that is being printed. 

16. If user defined interval is chosen the user can select which depth type, either measured depth, true 
vertical depth or subsea level depth from the depth measurement drop box. The user must also type 
in the depth interval to be printed. 

Note: The log itself must be displayed in whatever depth view you wish to print before you activate the print log 

window. To change the log to the desired format, refer to depth view under the view pull down menu. 

In the Cores portion of the Print Log Window 
17. If you are printing out a Core log on the tail of the striplog, select the Cores you wish to print by highlighting 

them. 

18.  Select or type in the Scale for the core log to be printed out at in the Scale drop box 
field. 
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19.  Activate this check box  to have the track headers printed out with the core log. 

20.  Activate this check box  to have the track footers printed out with the core log. 

Note: A separate Header Information Box is automatically printed out with every Core and includes the Core 

Scale, Core Date, Core Number, Cored Interval, Amount Cut, Amount Recovered, and Percentage. 

**A value must be entered into the Core Scale field in order to printout anything. ** 

21.  Activate this check box  if you wish to printout Formation Tops and the Formation 
Tops will be included on a separate page at the end of the log printout. 

 

 The page margin field is available, primarily, when you are printing to Adobe Acrobat writer. 
When a numerical value in inches is typed into this field it will initiate a top and left margin for the templates 
(Title Page, Legend and Formation Tops) as well as a left margin for the main log. 

 Activate this check box  if you are printing on single sheets. This will force the printer to include an 
additional 1/4 inch of the log at the top and bottom of each page, so that you can cut-and-paste pages manually, if 
you so desire. 
 

Activating the Default radio button  forces Power*Log / Core & Curve to use a raster or bitmap graphic printing 
method. This printing method is generally used with Laser printers but not exclusively so. 

Activating the Meta File radio button  forces Power*Log / Core & Curve to use the meta file 
technology printing method. This printing method was developed for the newer models of 
printers on the market today as well as using the Adobe Acrobat Distiller or pdf printing 

technology. 
 

Auto Activating the Auto radio button  forces Power*Log / Core & Curve to use the settings from the printer driver 
to printout the log. 

Color Activating the Color radio button  forces Power*Log / Core & Curve to override the 
printer driver settings and consequently Power*Log / Core & Curve assumes that you are 
using a color printer. 

Mono Activating the Mono radio button  forces Power*Log / Core & Curve to override the 
printer driver settings and consequently Power*Log / Core & Curve assumes that you are using a monochrome 
(black and white) printer. 

22. Click on the  button to activate the Print Setup window and confirm that the correct printer 
settings are in effect. 

Note: If you are printing out logs in color, you must activate the Diffusion or Error Diffusion option normally found 

under Graphics in the Properties window for most printers. 

23. Interval per page field indicates how many meters of log will fit on a page of selected paper size and 
orientation selected in the setup as well as what log scale you are printing at. This will help indicate to 
the user how many pages will be required by the print job. 

24.  Activate this check box  if the user wishes to have a blank page before the logs starts. 
This could be useful if utilizing continuous paper when you want the title page oriented on the 
correct side of the prefolded paper. 

25. When you are ready to print your log, click on the  button. 

Note: If you do exit from the Print Log window, you will be asked if you wish to save the print settings. If you 

click on Yes, the program will remember every setting that you made to the Print Log window and then will default 

to those settings the next time you enter the Print Log window 

44BPrint Morning Report 
Prints Morning Reports 

Under the File menu selection, click on Print Morning Report or click on the  Morning Report button on the 
Toolbar to activate the Print Morning Report window shown below: 
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Printing Morning Reportsé 
 
1. Select the printing destination from the Output field (in the upper left corner of the Morning Report window), 

drop box arrow: Printer, Preview, or Disk File. The Preview option allows you to see what your report looks like 
before it is printed. Note, however, that the Preview option will only preview one report at a time. Accordingly, 
when you wish to preview a specific report, please be sure that no other reports are selected / highlighted. 

2. If printing to a Disk File (on your hard drive or to a floppy diskette), select the file format from the Disk File 
Format field drop box arrow 

3. Click on  and a Save As window will pop up. Type in the in a five (5) character (or less) 

filename and click on the  button.  Power*Log / Core & Curve Ê will then attach an extra two (2) 
characters to the end of your filename to create a seven (7) character filename--preceding the standard three (3) 
character file extension. The two (2) characters added by Power*Log / Core & Curve Ê on to the end of the five 
(5) characters you have typed in are used as a reference by Power*Log / Core & Curve Ê to distinguish which 
reports are to be included in the files you are creating. Finally, the standard three (3) character file extension 
following the dot or period, will be selected according to the file format you selected in the Disk File Format field, 
e.g. MS Word documents will use the .DOC file extension. 

For example, if the five (5) characters you chose for a file name were "Trial" and you chose to print all Morning 
Reports with multiple days (and your Disk File Format was MS Word), you would end up with the following six (6) 
files: 

 

TRIALLT.DOC Summary and Lithology Report 

TRIALTG.DOC Total Gas Summary Report 

TRIALGS.DOC Gas Chromatography Summary Report 

TRIALFM.DOC Formation Report 

TRIALSC.DOC Formation, Lithology Summary and Chromatography 

TRIALSG.DOC Formation, Lithology Summary and Total Gas 

Note: You can then use a word processor, like MS Word, to access these files. 

4. Select a Well that includes your Morning Report(s) by clicking on the button and then double click on 
the desired Well from the ensuing Well List window. Please note that you may select numerous Wells, from the 
Well List window, for printing. Once you have selected your Well(s), you will then be returned to the Morning 
Report window. 
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Note: Only one well can be printed at one time, but you may print multiple days and reports for a single well all at 

once. 

**Only the selected/highlighted wells and their selected/highlighted reports will be printed. ** 

To highlight a Well, click on it once. To remove a Well from the Well List field, highlight the Well and click on the 

button. To remove all of the Wells from the Well List field, click on the button. Note that these 
buttons will not remove any of the Wells from the database. These buttons will only remove the Wells from the list of 
Wells currently available for printing. 

5. Highlight the appropriate Morning Report (listed by Date), and the related reports that you wish to print. You 

may click on the  button to print all of the Morning Reports from that Well. Conversely, to deactivate all of 

the Morning Reports, simply click on the  button. 

6. Click on the button to activate the Report Format window. 

 
Using the Format field drop down arrow, click on the style of Report Format that you wish to use. Then, click on the 

button, when you are finished. 

Note: Report Formats are useful, when you are printing reports for various clients, who prefer specific Report 

Formats. The formats store reports in their own directories, which Power*Log / Core & Curve Ê refers to when you 

choose to print reports in the specific formats. 

7. Click on the button and then select the 8.5ò x 11ò Portrait paper size. 

8. Click on the button in the main window. 
Formation Tops are automatically created in a Morning Report, if the depths specified fall within the range of the 
Morning Reports, two days prior to the day of printing. In order to have the Formation Tops printed, you must enter 
data into at least two Morning Report Date and Depth fields, prior to printing. Power*Log/CurveÊ searches for the 
Depth information to locate the Formation Tops it should include for the Date selected. 

**The Well End Report button will take you to the Well End Report window.** 

Note: When you exit from the Print Morning Report window, you will be asked if you want to save the print 

configuration. If you click on Yes, the program will remember every setting that you made to the window and will 

default to these settings the next time you enter the window. 
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45BPrint Well End Report 
Prints the reports for the end of a well 

Under the File menu selection, select Print Well End Report or click on the  Well End Report button on the 
Toolbar to activate the Print Well End Report window shown below: 

     
Printing a Well End Reporté 

1. Select the printing destination from the Output field (in the upper left corner of the Well End Report window), 
drop box arrow: Printer, Preview, or Disk File. The Preview option allows you to see what your report looks like 
before it is printed. Note, however, that the Preview option will only preview one report at a time. Accordingly, 
when you wish to preview a specific report, please be sure that no other reports are selected / highlighted. 

Note: To select or configure a specific printer, click on the  button. 

2. If printing to a Disk File (on your hard drive or to a floppy diskette), select the file format from the Disk File 
Format field drop box arrow 

3. Click on  button and a Save As window will pop up. Type in a filename and click on the  
button. Power*Log / Core & CurveÊ will then attach an extra two (2) characters to the end of your filename--
preceding the standard three (3) character file extension. The two (2) characters added by Power*SuiteÊ on to 
the end of the filename that you have typed in are used as a reference by Power*SuiteÊ to distinguish which 
reports are to be included in the file you are creating. Finally, the standard three (3) character file extension 
following the dot or period, will be selected according to the file format you selected in the Disk File Format field, 
e.g. MS Word documents will use the .DOC file extension. 

Note: The Rich Text File currently gives you the best formatting. We have a separate directory in reports especially 

formatted for RTF reports that can then be opened in word. 

Below is a list of two (2) character file name additions that Power*Log / Core & CurveÊ uses to identify different 
reports. For this example, a File Name of "Trial" with an MS Word Disk File Format will be used: 
 








































































































































































































































































































































































































































































































































































































































































































































































